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How to read this guide
The following shows the symbols used in this Quick start guide with descriptions and examples.

Symbol Description Example

This symbol explains information 
you need to know.

Select [View] → [Comment] (  key +  key). 
The comment display/hide setting can be switched.

This symbol describes the
references of manuals and pages
for more details.

For details, refer to the following manual.

QnUCPU User's Manual (Function 
Explanation, Program Fundamentals): SH-
080807ENG

This symbol describes content 
that must be noted in operation.

When mounting the module, the power must be turned 
OFF.

[ ] Menu names on the menu bar ([ ] 
→ [ ] shows drop-down menus.) Select [Project] → [New project].

Buttons on the screen  button

Keys on the keyboard  key

( )

Another procedure 
corresponding to a drop-down 
menu (icons and keys on the 
keyboard)

Select [Online] → [Monitor] → [Monitor mode] (  

key) (  ).

< > Tab names on the screen <Program common> tab

Point
Ctrl F5

Reference

Caution

F4

F3
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Generic terms
The following explains the terms used in this Quick start guide.

Generic term Description

Programmable controller 
system

Combination of the power supply module, the CPU module, the I/O modules, 
and the base unit.

Sequence control Consecutively processes each control step based on the fixed order or 
procedure.

QnACPU General term for the programmable controller CPU available in MELSEC-QnA.

GX Developer Application software to create sequence programs and communicate with the 
programmable controllers.

CPU module The core module to unify the controls of the programmable controllers. 
Q02UCPU is used in this Quick start guide.

Power supply module Supplies electricity to each module, including the CPU module and the I/O 
modules.

Base unit The unit that mounts the power supply module, the CPU module, and the I/O 
modules.

Building block

A method to organize one system by combining necessary elements.
Elements such as the power supply module, the CPU module, the I/O 
modules, and the base unit are combined in the programmable controller 
system.

Limit switch A switch to suspend mobile objects on both sides of a moving apparatus for 
safety reasons.

Relay Breaks/connects the electricity with electrical switching. 

Contactor Generally called an electromagnetic contactor to break circuits and switch the 
heater. 

Solenoid valve An electromagnet with a direct/alternating current solenoid valve. Connected 
to the output side of the programmable controller.

Ground Prevents electric shocks and malfunctions.

Control panel
Transfers signals to other equipment. Combines such elements as breakers, 
switches, protection equipment, relays, and programmable controllers. 
Receives signals from switches and sensors, and supply electricity to operate 
motors and solenoid valves of the machines and equipment. 

Isolation transformer
A two-winding transformer.
The primary and secondary coil are wound separately to protect the secondary 
load. 

Contact An input used when creating a sequence program. 

Coil An output used when creating a sequence program.

Device A location to store data such as ON/OFF, numeric values, and character 
strings in the programmable controller.

Internal relay Breaks/connects the sequence circuit by switching ON/OFF.

Sequence program A program to perform sequence control.

Project 
Indicates a GX Developer project in this Quick start guide.
Consists of programs, device comments, and parameters. 

Parameter
Setup information necessary to operate the programmable controller system.
Modules and the network are set by writing parameters to the CPU module.

PLC parameter Setup information for modules, devices, and programs used in the 
programmable controller system.

Step number Numbers attached in order from the start of instruction in the sequence 
program.

Logical operations
One of the basic operation methods in programming.
Logical operations consist of three basic operations: logical AND, logical OR, 
and logical NOT.

Debug An operation in which programmers search for and correct bugs in the 
sequence program.



3

Introduction
This Quick start guide explains the basic procedures for the first-time use of the Mitsubishi 
programmable controller MELSEC-Q series CPU module (CPU module).
You can easily understand how to use the programmable controller with this manual.

Reference

Precautions
Read "SAFETY PRECAUTIONS" in the QCPU User's Manual carefully and use the
programmable controllers safely.

Types of CPU modules
This Quick start guide explains the usage examples for Universal model QCPU. For the
usage of other CPU modules, refer to the following manuals and be aware of the
differences.

QCPU User's Manual (Hardware Design, Maintenance and Inspection): 
SH-080483ENG

Qn(H)/QnPH/QnPRHCPU User's Manual (Function Explanation, Program 
Fundamentals): SH-080808ENG
QnUCPU User's Manual (Function Explanation, Program Fundamentals): 
SH-080807ENG

QCPU Programming Manual (Common Instructions): SH-080809

QnACPU Programming Manual (Common Instructions): SH-080810

Caution

This Quick start guide explains operations in the programmable controller system described
in "2 System Configuration" (P.9).
Read the manuals referred in the following page when you design or manage the system.

Introduction of related manuals (P.6)

Quick start guide

Mounting and wiring modules

Checking operations

Creating programs

100VAC

24VDC

(Y10)

(Y1B)

(Y1F)

0

3

X1X0

X2



4

Programmable controllers
The programmable controllers perform sequence control and logical operations by switching the 
output of output equipment ON/OFF according to the command signal from the input equipment.

Other equipment is shown below.

Power Power

<Input equipment> <Programmable controller> <Output equipment>

Push-button switch

Input module

Operation

O
u

tp
u

t 
in

te
rf

a
c
e

 M
e

m
o

ry

CPU module Output module

Data

Program

Personal computer

Creating and

debugging programs

In
p

u
t 

in
te

rf
a

c
e

QX40

24VDC
4mA

NC

QY40P

24VDC
0 . 1A

12VDC

<Examples of input equipment>

Limit switch Input relay Switch

<Examples of output equipment>

Contactor Solenoid valve
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Programmable controller usage example
This example shows the programmable controller system in a beverage plant.

The following explains the procedure for putting bottles in a case.

1 When the switch is turned ON, the "IN OPERATION" lamp is lit, and the conveyor is set in 
operation.

2 When the conveyor brings a bottle case to a particular position, the sensor senses it.
3 When the bottle case is sensed, the stopper operates to stop it.
4 The lifter goes up, the arm moves forward, and the lifter goes down to put bottles in the case.
5 One is added to the value in the product counter.
6 When the CPU module concludes that the above procedure is completed, the stopper goes down 

to let the cases flow.

Repeat procedures 2 to 6.

IN OPERATION

Beverage plant

CONTROL
START

 STOP

 COUNTER

4 Lifter 4 Arm

1 Lamp

1 Conveyor 2 Sensor

6 CPU module

5 Product

    counter

1 Start switch

36 Stopper
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Introduction of related manuals
This Quick start guide explains the basic procedures for introducing programmable controllers.
Read the following manuals to use each module with a full understanding according to your purpose.

Learning about programmable controllers

Learning about programming

Learning about programming tools (software)

QCPU User's Manual (Hardware Design, Maintenance and Inspection) . . . . .SH-080483ENG
This manual explains specifications, settings, and maintenance methods for the CPU 
module, the power supply module, and the base unit.

Qn(H)/QnPH/QnPRHCPU User's Manual (Function Explanation, Program Fundamentals)
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .SH-080808ENG

QnUCPU User's Manual (Function Explanation, Program Fundamentals). . . .SH-080807ENG
This manual explains the functions of the CPU modules, and about devices and parameters 
that are the basic knowledge necessary for programming.

I/O Module Type Building Block User's Manual . . . . . . . . . . . . . . . . . . . . . . . . . . . .SH-080042
This manual explains specifications and functions for the input module and the output 
module.

QCPU Programming Manual (Common Instructions) . . . . . . . . . . . . . . . . . . . . . . . .SH-080809

QnACPU Programming Manual (Common Instructions). . . . . . . . . . . . . . . . . . . . .  SH-080810
This manual explains the instructions used in programming.

GX Developer Version 8 Operating Manual (Startup)  . . . . . . . . . . . . . . . . . . . . .  SH-080372E
This manual explains the installation method for GX Developer Version 8.

GX Developer Version 8 Operating Manual  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  SH-080373E
This manual explains operation methods including program creation, parameter setting, 
writing/reading programs, and debugging.
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Using programmable controllers
The programmable controllers are installed with procedures as shown below.

1 Preparing for Operation (P.8)

Preparing the necessary equipment.

2 System Configuration (P.9)

Introducing equipment used for operations in this Quick start guide.

3 Mounting Modules (P.10)

Mounting the CPU module and other modules on the base unit.

4 Wiring Modules (P.11)

Wiring the power supply module, the CPU module, and the I/O modules.

5 Checking Power Supply (P.13)

Turning ON the system to check the condition of the CPU module.

6 Programming (P.14)

Creating a program with GX Developer.

7 Writing Programs (P.21)

Writing a program created with GX Developer to the CPU module.

8 Checking Operation (P.25)

Executing the program by running the CPU module. Checking that ON/OFF 
inputs correspond to ON/OFF outputs.



8

 1Preparing for Operation
Preparing the necessary equipment

* GX Developer Version 8 needs to be installed in your personal computer in advance.

Reference

GX Developer, the design and maintenance tool for Mitsubishi programmable controller, is
necessary to set up programmable controllers and create sequence programs.

For the installation and operation of GX Developer, refer to the following manuals.

GX Developer Version 8 Operating Manual (Startup): SH-080372E

GX Developer Version 8 Operating Manual: SH-080373E

Compatible GX Developer version
The CPU module used and its functions differ in each version of GX Developer.
For the compatible GX Developer version, refer to the following manual.

QCPU User's Manual (Hardware Design, Maintenance and Inspection): 
SH-080483ENG

5 Lamp 6 Switch

1 Programmable controller 2 Personal computer 3 GX Developer

4 USB cable

Explanations for each 
module are on the next 
page

Windows-based PC

Version8

USB mini B type

Install *
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2 System Configuration
System configuration example
This Quick start guide explains the following system configuration as an example.

Inputs and outputs are configured as switches and lamps respectively.

* Wires to the power supply module and the power of the I/O modules are omitted.

No. Name Model

1 Base unit Q33B

2 Power supply module Q62P

3 CPU module Q02UCPU

4 Input module QX40

5 Output module QY40P

6 Connection cable (USB cable)
MR-J3USBCBL3M 

(USB A type - USB mini B type)

Switch (input) Lamp (output)Programmable controller

QY40P
0 1 2 3 4 5 6 7
8 9 A B C D E F

0

1
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3
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5

6

7

8

9

A

B

C

D

E

F

COM

24VDC
0 . 1A

12VDC

QX40
0 1 2 3 4 5 6 7
8 9 A B C D E F

0

1

2

3

4

5

6

7

8

9

A

B

C

D

E

COM

F

24VDC
4mA

NC

1

2 5

4

3

6
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3 Mounting Modules
Mount prepared modules on the base unit.

A battery connector must be installed when using the CPU module for the first time.

Mounting modules

Caution

The power supply must be disconnected when mounting modules.

Point

Installing a battery in the CPU module

Base unit
Module

Side view

Side view

Module fixing
projection

Module fixing
projection

Base unit

Module
fixing hole

1 Insert a module fixing 

 projection into a module 

 fixing hole on the base 

 unit.

2 Push the module in the 

 direction of arrow until 

 it clicks.

Complete

Module
Module

fixing hole

1 Open the cover at the

 bottom of the CPU module. 

2 Insert the connector of

 battery into the connector

 of CPU module.

3 Close the cover at the

 bottom of the CPU module.

2

3

Connector of

CPU module

Connector of

battery Battery

CPU moduleComplete
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4 Wiring Modules
Wire the power supply module, the input module, and the output module.

Wiring the power supply module
The following shows an example of wiring the power line and the ground wire to the base unit.

Wiring the input module
The following shows an example of wiring the input module (QX40).

Caution

The power supply must be disconnected when wiring modules.

Reference

For details of wiring precautions, refer to the following manual.
QCPU User's Manual (Hardware Design, Maintenance and Inspection): SH-080483ENG

ERR

24V

24VDC
0.5A

24G

(FG)

(LG)

N

L

INPUT

ERR

2 FG

2 LG

1 INPUT
 100-120VAC

1 Connect the
 100VAC power
 supply to the
 power input
 terminals.

2 Connect the LG

 and FG terminals.

Power supply module
(Q62P)

Ground

wire
Grounding

100VAC

AC

Switch 1

Signal: X0

Switch 2

Signal: X1

Switch 3

Signal: X2

24VDC
4mA

NC
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Wiring the output module
The following shows an example of wiring the output module (QY40P).

Point

Wire the power supply lines separately for the I/O equipment and the programmable
controller as shown below.

16

17

18

15

14

13

12

11

10

9

8

7

5

5

4

3

2

1

0 1 2 3 4 5 6 7
8 9 A B C D E F

24VDC
12VDC

0 . 1A

L

Lamp 1

Signal: Y10

L

Lamp 2

Signal: Y1E

L

Lamp 3

Signal: Y1F

100VAC

200VAC

Main power

supply Relay terminal

block

Programmable controller

power supply

Programmable

controller

I/O equipment

Isolation

transformer

Inside of control panel

I/O power supply

T1
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5 Checking Power Supply
Check that the power supply runs normally after configuring the system, mounting modules, and 
wiring.

Operating procedure

1. Check before turning ON the power supply.
• Wiring of the power supply
• Power supply voltage

2. Set the CPU module to STOP.
Set the switch on the front of the CPU module to STOP.

3. Supply power.

4. Check that the power supply runs normally.

Check the front LEDs on each module.
The following shows the normal state of the LEDs.
1 Power supply module: "POWER" LED lights in

green.
2 CPU module: "MODE" LED lights in green.

Construction of the system is complete. 
Turn OFF the power supply.

Point

Troubleshooting
1 When the "POWER" LED, "MODE" LED are OFF or flashing, refer to the following page.

Troubleshooting (P.28)

2 When a parameter or program is not written to the CPU module,
the "ERR." LED flashes red, but it is not a problem at this stage.

RESET/STOP/RUN

1 2

"ERR." LED

flashes red.
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6 Programming
Create a program (sequence program) for sequence control.

"Devices" and "instruction symbols" in programming
Combine "devices" and "instruction symbols" to create a sequence program.

1. Devices
Devices include bit devices and word devices.
1 Bit device: handles one-bit information such as ON/OFF of a switch or a lamp.

Examples of bit device

2 Word device: handles 16-bit information such as numeric values and character strings.

Examples of word device

Device name Device 
symbol Description

Input X Receives a signal from an external device such as a switch.
Output Y Outputs a signal to an external device such as a lamp
Internal relay M Temporarily saves data status in programs.

Timer (contact) T Used to measure time (when the set time comes, the contact is set to 
ON).

Counter (contact) C
Used to count the number of times the input condition turns from OFF 
to ON (when the counter reaches the set number, the contact is set to 
ON). 

Device name Device 
symbol Description

Data register D Registers numeric values and character strings.
Timer (current value) T Used to measure time (stores the current value of measuring time).

Counter (current value) C Used to count the number of times the input condition turns from OFF 
to ON (stores the current value of the counter).

ON/OFF of a switch ON/OFF of a lamp

Numeric value Character string
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2. Instruction symbols
The following shows the basic instructions of sequence control.

Creating a program
Create a sequence program.

The following shows how to create a sequence program with basic devices and instruction symbols 
for sequence control.

The following devices and instruction symbols are used.

• Input: X device

• Output: Y device

• Instruction symbols: , , 

Create a program that performs the following controls.

• When the X0 and X1 switches are turned ON, the Y10 output lamp turns ON.

• When the X2 switch is turned ON, the Y1E and Y1F output lamps turn OFF.

The following explains the procedure to create this sequence program.

Instruction 
symbol Description

Open contact: Conducts when an input signal is 
set to ON.

Closed contact: Conducts when an input signal is 
set to OFF.

Coil output: Outputs data to a specified device.

Reference

This section explains the most basic devices and instructions.
In addition to those listed above, other devices and instructions convenient for sequence
control are available.

QCPU Programming Manual (Common Instructions): SH-080809

QnACPU Programming Manual (Common Instructions): SH-080810

 

QY40P
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[END]
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Starting GX Developer

Operating procedure

After starting, the GX Developer main screen is displayed.

Creating a new project

Operating procedure

Select [Start] � [All Programs]

� [MELSOFT Application]

� [GX Developer].

1 Select [Project] �

    [New project]

    (          key +       key) (     ).

2 Select QCPU (Q mode).

3 Select the QCPU to be used

    (Q02UCPU in this manual).

4 Click the                   button.

A project tree is displayed.

A ladder screen is displayed.
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Entering a sequence program

Operating procedure

1. Enter .

2. Enter .

3. Enter .

2 Enter device X0.

3 Click the              button.

1 Click        (         key).

2 Enter device X1.

3 Click the             button.

1 Click        (         key).

2 Enter device Y10.

1 Click        (         key).

3 Click the             button.

Coil Y10 is displayed.
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4. Enter .

5. Enter .

6. Draw a line.

2 Enter device X2.

1 Click        (         key).

3 Click the             button.

2 Enter device Y1E.

1 Click        (          key).

3 Click the              button.

Coil Y1E is displayed.

2 Drag and drop in the

     direction of the arrow.

1 Click       (         key).
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7. Enter .

Converting a program
Define the contents of the entered ladder block.

Operating procedure

Perform the conversion to align entered ladders. When completed, the gray display turns to white.
[Before conversion]

[After conversion]

The programming is completed.

2 Enter device Y1F.

1 Click        (         key).

3 Click the             button.

Coil Y1F is displayed.

Select [Convert] � [Convert]

(         key).

The ladder is left-aligned.
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Saving a project
A program is saved in unit of project.

Save the created project with a name.

Operating procedure

The "Save the project with a new name" screen is displayed.

The project is saved.

1 Select [Project] � [Save as]

     (      ). 

4 Click the                       button.

2 Specify the save location.

3 Enter the name and title

     of the project.

5 Click the                   button.
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7 Writing Programs
Write the program to the CPU module.

Connecting the CPU module and the personal computer
Connect the CPU module and the USB port of the personal computer with a USB cable.

Turning ON the programmable controllers
Turn ON the power supply module, the input module, and the output module.

Setting GX Developer and the programmable controller connection

Operating procedure

The "Transfer Setup" screen is displayed.

                            To the next page

Personal computer CPU module
QY40P

0 1 2 3 4 5 6 7
8 9 A B C D E F

0

1

2

3

4

5

6

7

8

9

A

B

C

D

E

F

COM

24VDC
0 . 1A

12VDC

QX40
0 1 2 3 4 5 6 7
8 9 A B C D E F

0

1

2

3

4

5

6

7

8

9

A

B

C

D

E

COM

F

NC

24VDC
4mA

 1 Select [Online] � [Transfer setup].

2 Double-click "Serial USB".
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The "PC side I/F Serial setting" screen is displayed.

When properly connected, the connection completion message is displayed.

∗ When the screen on the right is displayed, check the system and 
the settings.

Troubleshooting (P.28)

The connection setting is completed.

3 Select "USB".

4 Click the                   button.

5 Click "PLC module".

6 Click "No specification".

7 Click the                              button.

8 Click the                    button.

9 Click the                   button.
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Formatting the CPU module
Before writing the program, format the CPU module to set it to the initial status.

Operating procedure

The "Format PLC memory" screen is displayed.

The CPU module format is completed.

Click the  button to close the "Format PLC memory" screen.

Point

When data such as programs and parameters are already stored in the CPU module, they
are deleted. Thus the necessary data should be read from the programmable controller
CPU and saved as a project before executing the Format PLC memory function.

1 Select [Online] � [Format PLC memory].

3 Click the                    button.

2 Select "Program memory/Device 

     memory" from "Target memory".

4 Click the                   button.

5 Click the                   button.
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Writing programs to the CPU module

Operating procedure

The "Write to PLC" screen is displayed.

When the Write to PLC function is properly executed, the following message is displayed.

The program writing is completed.

Click  to close the "Write to PLC" screen.

Point

PLC parameter
The PLC parameter is necessary to start the CPU module. The default values are used in
this system configuration.
For details of setting parameters, refer to the following manuals.

Qn(H)/QnPH/QnPRHCPU User's Manual (Function Explanation, Program 
Fundamentals): SH-080808ENG

QnUCPU User's Manual (Function Explanation, Program Fundamentals):
SH-080807ENG

1 Select [Online] 

  � [Write to PLC] (      ).

4 Click the                     button.

2 Click "Param+Prog".

    �

3 "Program" and "Parameter" 

     are checked.

5 Click the                   button.
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8 Checking Operation
Execute the program written to the CPU module to check the operation.
Check the program operation with the switches and lamps or the monitor function of GX Developer.

Executing the program written to the programmable controller CPU
Use the "RESET/STOP/RUN" switch on the front of the CPU module for the operation.
The usage of the RESET/STOP/RUN switch
 • RUN    : Executes the sequence program operation.
 • STOP  : Stops the sequence program operation.
 • RESET: Performs the hardware reset, operation error reset, and operation initialization.

Operating procedure

1. Resetting the CPU module

Reference

When the flashing "ERR." LED does not turn OFF, refer to the following page.

Troubleshooting (P.28)

RESET/STOP/RUN

switch

  [LED display before resetting]

2 Tilt the "RESET/STOP/RUN" switch toward "RESET" on the front of the CPU module.

     (for over a second)

1 Check the LED status before resetting the CPU module.

3 After the flash, "ERR." LED turns OFF, then release the switch.

 [Resetting]

 [Resetting completed]

4 The switch returns to "STOP", and the resetting is completed.

MODE: Green: ON

RUN : OFF

ERR.: Red: Flashing slow

MODE: Green: ON

RUN : OFF

ERR.: Red: Flashing fast

MODE: Green: ON

RUN : OFF

ERR.: OFF

Hold for over a second
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2. Executing the program

Using switches and lamps to check the operation
Check the program operation by turning the switches and lamps ON/OFF.
If all of the switches (X0, X1, X2) are OFF right after the execution of the program, the output lamp 
Y10 stays OFF and the output lamp Y1E and the output lamp Y1F stay ON due to the instructions 
from the created program.

1. Operation check 1
Turn ON the switch X0. The output lamp Y10 stays OFF and the output lamp Y1E and Y1F 

stay ON.

2. Operation check 2
Turn ON the switch X1. The output lamp Y10 turns ON.

3. Operation check 3
Turn ON the switch X2. The output lamp Y1E and Y1F turn OFF.

Checking the operation in GX Developer
Check the program operation by using the monitor mode on the GX Developer screen, where the 
status of switches and lamps can be operated and checked.

Operating procedure

1. Set the operating program display screen to the monitor mode.

                            To the next page

Caution

Do not use pointed tools such as a screwdriver when operating the switch.
They may damage the switch.

1 Tilt the "RESET/STOP/RUN" switch toward "RUN" on the CPU module.

LED display at the STOP status

2 If the "RUN" LED turns ON green, the program is running normally.

LED display at the RUN status

MODE: Green: ON

RUN : OFF

MODE: Green: ON

RUN : Green: ON

Select [Online] � [Monitor]

� [Monitor mode] (         key)

(       ).
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Execute the monitor to display the "Monitor status" screen.

The ON/OFF status of bit devices can be checked on the ladder screen.
Contacts/outputs set to ON are displayed in blue.
Right after the program execution, bit devices X02, Y1E, and Y1F are lit blue due to the instructions 
from the program.

2. Operation check 1

3. Operation check 2

4. Operation check 3

Point

While pressing the  key, double-click devices set to ON in Operation checks 1 and 2
to turn them OFF.

Displayed in blue

Displayed in blue

1 Double-click X0 while pressing

     the            key � X0 turns ON.
Displayed in blue

Displayed in blue

   �

Y10 turns ON.

2 Double-click X1 while pressing       

     the            key � X1 turns ON.

Displayed in blue

Displayed in blue

             �

Y1E and Y1F turn OFF.

3 Double-click X2 while pressing

     the            key � X2 turns ON.
Displayed in blue

Displayed in blue

Shift
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Troubleshooting
When modules do not run normally, refer to the following troubleshooting information.

Programmable controller troubleshooting

1. First, check the following points.
1) The ON/OFF status of the power supply
2) The mounting condition of the power supply module, the CPU module, and the I/O modules
3) The LED on the front of the CPU module

2. Check the problem and respond according to the following list.

Problem Check Action

The "POWER" LED is 
OFF after turning ON the 
power supply module.

Is the power supply module 
properly wired and 
mounted?

Wire and mount the module properly.
 3 Mounting Modules (P.10)
 4 Wiring Modules (P.11)

The "ERR." LED on the 
CPU module is flashing 
red.

Are programs and PLC 
parameters written to the 
CPU module?

Write programs and parameters to the CPU 
module.

 7 Writing Programs (P.21)

If the CPU has several 
programs, are they 
registered to the PLC 
parameter?

If there are several programs, register them in the 
program setting of the PLC parameter, and write 
the parameters to the CPU module.
If several programs are not needed, delete 
unnecessary data, or execute the Format PLC 
memory function before writing data to the 
programmable controller CPU.

 GX Developer Version 8
Operating Manual: SH-080373E

Other than above Handle by checking for errors following "Checking 
errors in the CPU module" (P.30) in this manual.

The "BAT" LED on the 
CPU module is ON or 
flashing.

Is the battery properly 
connected?

Properly connect the battery.
 3 Mounting Modules (P.10)

Reference

For details of the troubleshooting, refer to the following manual.
QCPU User's Manual (Hardware Design, Maintenance and Inspection):
SH-080483ENG
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Troubleshooting when using GX Developer
Check the problem and respond according to the following list.

Problem Check Action

The CPU module cannot 
communicate with the 
personal computer (GX 
Developer).

(Communication error 
message)

Is the correct cable used?
Check the cables.

 GX Developer Version 8 
Operating Manual: SH-080373E

Is the GX Developer 
transfer setup properly 
set?

Check the transfer setup.
  7 Writing Programs (P.21)

Is the USB driver properly 
installed?

Properly install the USB driver, referring the 
following manual.

GX Developer Version 8 
Operating Manual (Startup): 
SH-080372E

Programs cannot be written.
Has a write protect 
password been set in GX 
Developer?

Unlock the password.
 GX Developer Version 8 
Operating Manual: SH-080373E
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Checking errors in the CPU module
If a problem occurs, errors can be checked by diagnosing the programmable controller CPU in GX 
Developer.

Operating procedure

PLC Diagnostics screen (example)

Help screen (example)

1 Select [Diagnostics] � 

     [PLC diagnostics].

(Error log)

 2 Click the              button.

(Present Error)

 2 Click the              button.

Current errors and corrective

actions are displayed.
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Frequently-used functions
This section explains functions frequently used in GX Developer.

Clarifying programs <Comment> (P.32)
Device comment

Statement

Note

Monitoring device values and status <Device monitor> (P.37)
Device batch monitor

Entry data monitor

Changing device values <Device test> (P.41)
Bit device forced ON/OFF

Word device current value modification

Changing running programs <Online program change> (P.43)

Checking errors <Error jump> (P.44)

Monitoring system status <System monitor> (P.45)
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Clarifying programs <Comment>
Use comments to clarify the contents of a program.

The followings are the three types of comment.

Creating device comments
Device comments can be entered from the list or on the ladder diagram.

<Input operation from the list>

Operating procedure

 To the next page

Type Description Number of characters

Device comment Describes roles and usage of each device. 32

Statement Describes roles and usage of ladder blocks. 64

Note Describes roles and usage of output instructions. 32

Point

Select [View] → [Comment] (  key +  key) to switch the comment display/hide
setting.

Statement

Note

Device 

comment

Ctrl F5

1 Double-click [COMMENT]

     under [Device comment] 

     in the project list.
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<Input operation on the ladder diagram>

Operating procedure

2 Enter the start device number 

     in "Device name".

3 Click the                   button.

4 Enter a comment in

     the "Comment" column.

5 When entering comments for

     other devices, enter a device

     number again as in the step 2.

6 Click       to close the screen.

1 Select [Edit] � [Documentation]

     � [Comment] (        ).

2 Double-click the ladder

     symbol to enter a comment.

3 Enter a comment on the

     "Enter device comment" screen.

4 Click the                   button.

5 Select the [Comment] menu in 

     the step 1 again to finish the 

     operation.
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Point

Entering comments when creating ladders

Operating procedure

After the ladder input operation, the "Enter device comment" screen is displayed to enter a
comment.

1 Select [Tools] � [Options].

2 Check "Continues during

     command write" of "Comment

     input" in the <Program common> 

     tab.

3 Click the                   button.
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Creating statements

Operating procedure

If a statement is entered, a program needs to be "converted" to reflect the input. For details on the
conversion, refer to the following page.

6 Programming - Converting a program (P.19)

Point

The followings are the two types of statement.

Integrated (Embedded) statement
Integrated statements can be written to/read from the CPU module.

Peripheral (Separate) statement
The program memory capacity can be saved since peripheral statements are not written to
the CPU module. "*" is prefixed to the peripheral statement in the program.

1 Select [Edit] � [Documentation] � 

  [Statement] (         ).

2 Double-click a ladder block to

     enter a statement.

3 Select "Embedded".

4 Enter a statement on the

     "Enter line statements" screen.

5 Click the              button.

6 Select the [Statement] 

     menu in the step 1 again to finish 

     the operation.
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Creating notes

Operating procedure

Point

The followings are the two types of note.
Integrated (Embedded) note
Integrated notes can be written to/read from the CPU module.
Peripheral (Separate) note 
The program memory capacity can be saved since peripheral notes are not written to the
CPU module. "*" is prefixed to the peripheral note in the program.

1 Select [Edit] � [Documentation] � 

     [Note] (       ).

2 Double-click the output  

  instruction symbol to enter a 

  note.

3 Select "Embedded".

4 Enter a note on the "Enter Note" 

     screen.

6 Select the [Note] menu in the 

     step 1 again to finish the 

     operation.

7 Click        to close the screen.

5 Click the             button.
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Monitoring device values and status <Device monitor>
The followings are the two types of device monitor.

Device batch monitor
Monitors consecutive devices by specifying the start device number.

Operating procedure

* The "Device batch monitor" screen can be displayed by selecting [Device batch] with a right click 
on the ladder screen.

 To the next page

Type Purpose

Device batch monitor Used to monitor consecutive devices of one type.

Entry data monitor Used to simultaneously monitor separately-located devices in 
the ladder or various devices on one screen.

1 Select [Online] � [Monitor] 

  � [Monitor (Write mode)] 

  (         key) (       ).

2 Select [Online] � [Monitor] � 

     [Device batch] (       ).

3 Enter the start device number 

  to be monitored on the "Device 

  batch monitor" screen.

4 Click the                       button.
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The values of devices and the ON/OFF status of contacts/coils are displayed.

Entry data monitor
The device registration methods used to perform the Entry data monitoring are the specified device 
registration and the device registration with ladder monitor display.

<Specified device registration>
Register specified devices on the "Entry data monitor" screen.

Operating procedure

*The "Entry data monitor" screen can be displayed by selecting [Entry data monitor] with a right click on
the ladder screen.

 To the next page

5 Click       to close the screen.

1 Select [Online] � [Monitor] � 

     [Monitor (Write mode)] (         key)

     (       ).

2 Select [Online] � [Monitor] � 

     [Entry data monitor] (       ).

3 Click the                   button 

     on the "Entry data monitor" 

     screen.                
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The specified device is registered on the "Entry data monitor" screen.

The values of devices and the ON/OFF status of contacts/coils are displayed.

<Device registration with ladder monitor display>
Specify the range of the ladder diagram in the ladder monitor screen and register the devices in a 
batch.

*The "Entry data monitor" screen can be displayed by selecting [Entry data monitor] with a right click on
the ladder screen.

 To the next page

4 Enter the device number 

     on the "Register device" screen.

5 Select "Display format".

6 Click the             button.

7 Click      to close the screen.

8 Click the                     button.

9 Click the                     button 

     to finish monitoring.

1 Select menu [Online] � [Monitor] 

     � [Monitor (Write mode)] 

     (         key) (       ).

2 Select menu [Online] � [Monitor]

     � [Entry data monitor] (       ).
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*Set the "Entry data monitor" screen to the monitor stop status.

The ladder screen and the "Entry data monitor" screen are displayed horizontally.

Register devices to the "Entry data monitor" screen.

The values of the selected devices are monitored.

3 Select [Window] �

     [Tile horizontally].

4 Click the start point of the ladder.

5 Click the end point of the ladder 

     while pressing the            key 

     (specify the range).

6 Drag and drop the selected 

     range to the "Entry data monitor" 

     screen.

7 Click the                        button.
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Changing device values <Device test>
This function forces bit devices (such as X, Y, M, C) of the CPU module ON/OFF, or changes the 
current value of the word device (such as T, C, D) to the specified value.

Bit device forced ON/OFF
Forcing bit devices (such as X, Y, M, C) of the CPU module ON/OFF.

Operating procedure

* The "Device test" screen can be displayed by selecting [Device test] with a right click on the ladder 
screen. 

Point

Forcing a bit device ON/OFF with the key operation

Double-click the specified bit device on the ladder monitor screen while pressing the 
key to force it ON/OFF.

1 Select [Online] � [Monitor] � 

     [Monitor (Write mode)] (          key) 

     (        ).

2 Select [Online] � [Debug]

     � [Device test] (         key +       key).

3 Enter the device number to be 

  forced ON/OFF.

4 Force the device ON/OFF

                      : Force the device ON.

                      : Force the device OFF.

                      : Force the device ON/OFF 

                        with each click.

Shift
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Word device current value modification
Changing the current value of the word device (such as T, C, D) in the CPU module to the specified 
value.

Operating procedure

* The "Device test" screen can be displayed by selecting [Device test] with a right click on the ladder 
screen.

1 Select [Online] � [Monitor] � 

     [Monitor (Write mode)] (         key)

     (       ).

2 Select [Online] � [Debug] � 

     [Device test] (          key +        key).

3 Enter the device number to be 

  changed.

4 Enter the value to be changed.

5 Click the             button.
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Changing running programs <Online program change>
This function writes only the modified ladder block to the CPU module while the CPU module is in the 
"RUN" status.
A program can be written in a short time since this function does not transfer the whole program.

The following is an example of adding a contact to the ladder.

Operating procedure

When the online program change has been properly completed, the following message is displayed.

Caution

The program in the CPU module and the program to be modified in GX Developer must be
the same to perform the online program change. When you are not sure, verify the
programs in advance or modify the ladder after performing the "Read from PLC" function.

1 Select (        Write mode) while 

     displaying the ladder.

2 Add a contact.

The ladder block is 

displayed in gray.

3 Select [Convert] � 

    [Convert (Online change)]

    (            key +          key).

4 Click the                     button.   

5 Click the                    button to 

    close the screen.
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Checking errors <Error jump>
Errors can be checked easily with the error jump function of PLC diagnostics.

Operating procedure

The cursor jumps to the step number of the sequence program corresponding to the selected error.

1 Select [Diagnostics] � 

     [PLC diagnostics]

    from the GX Developer menu.

2 Click the                button.
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Monitoring system status <System monitor>
This function monitors the system status of the CPU module and other modules.

Operating procedure

The "System Monitor" screen is displayed.

No. Description

1 Installed status: Displays the modules installed on the base unit.

2 Parameter status: Displays the parameter setting status written to the CPU module.

3 Status: Classifies error status of 4 by color.

4
Base: Displays the normal status in white and abnormal in red.
Module: Displays the error status with the color in 3.

Select menu [Diagnostics] � 

[System monitor].

1 Installed status

2 Parameter status

3 Status

4 Base
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Point

The information of each module can be checked from the "System Monitor" screen.

Double-click the CPU module.

� The "PLC diagnostics" screen is displayed to 

    check the operation status of the CPU module.

Double-click each module (except the CPU module and 

power supply module).

� The "Module's Detailed Information" screen is 

    displayed to check the status of each module.
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MEMO
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